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บทที่ 1 

Web Mail Samoware  
 

CommuniGate Pro Messaging System เป็นระบบอีเมลที่ให้บริการโดยเน้นการทำงานผ่านเว็บเป็น

หลัก ผู้ใช้สามารถเรียกใช้งานผ่านเว็บบราวเซอร์ (Web Users) บนเครือข่ายที่ให้บริการ ด้วยการทำงานผ่านเว็บ 

แต่สามารถทำงานต่างๆ ได้เสมือนเป็นโปรแกรม Clients พร้อมด้วยฟังก์ชันที่หลากหลาย   

 

การเริ่มต้นการใช้งาน 

1. ทำการเปิดโปรแกรม Web Browser ที่ต้องการใช้งานในเครื่อง  

 

รูปที่ 1-1 การเรียกใช้งานโปรแกรม Browser Google Chrome 

 

2. ที่ Address Bar ใส่ที่อยู่ของระบบ https://mail.excise.go.th 

 

รูปที่ 1-2 แสดงการป้อนที่อยู่เพ่ือเข้าสู่หน้า Web mail 
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3. เข้าสู่หน้าแรกของระบบWeb mail ทำการป้อน Username (ไม่ต้องใส่ @excise.go.th) และ 

Password จากนั้นคลิกท่ี “Log in” เพ่ือเข้าสู่ระบบ  

 

 
รูปที่ 1-3 แสดงหน้า Login ระบบWeb mail 

 
  

4. เข้าสู่หน้าแรกระบบ Web mail 

 

รูปที่ 1-4 แสดงหน้าแรกของระบบ Web mail 
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1.1. องค์ประกอบของ Web mail 

1.1.1. Available Modules 

ประกอบด้วยเมนูสำหรับเข้าสู่ฟังก์ชันต่างๆ ในระบบ ซึ่งอยู่ด้านซ้ายมือ 

 

รูปที่ 1-5 แสดง Available Modules สำหรับเข้าสู่ฟังก์ชันหลักต่างๆ ของระบบ 

 

1.1.2. Actions Bar 

แสดง Actions Bar ที่อยู่ในแต่ละฟังก์ชัน จากรูปตัวอย่างด้านล่างจะเป็น Actions Bar ที่อยู่ในส่วนของ

การจัดการข้อความ 

 

รูปที่ 1-6 แสดงฟังก์ชันย่อยของการจัดการข้อความ 
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1.1.3. Current Module Options 

แสดง Options ที่เรียกใช้งานอยู่ปัจจุบัน จากรูปตัวอย่างด้านล่างจะเป็น Options ที่อยู่ ในส่วนของ Mail 

 

รูปที่ 1-7 แสดง Options ของ Mail 
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บทท่ี 2 
Folder / Mailbox 

 

ใน Web Samoware จะมีเครื ่องมือที ่จะช่วยให้ผู ้ใช้สามารถสร้าง Mailbox ได้ตามความต้องการ  

อย่างง่ายดาย นอกจากนี้ ด้วยความสามารถ drag and drop ของ Web Samoware ยังช่วยผู ้ใช้ย้ายข้อมูล

ระหว่างโฟลเดอร์โดยใช้วิธีการลากข้อความมาใส่ในโฟลเดอร์ที่ต้องการได้อีกด้วย  

ผู้ใช้สามารถสร้างโฟลเดอร์ได้อยู่ 2 แบบ คือ  

1. Mailbox เป็นโฟลเดอร์ที่ใช้ในเก็บข้อมูลที่เป็นอีเมล 
2. Address Book เป็นโฟลเดอร์ที่ใช้เก็บข้อมูลที่เป็นข้อมูลผู้ติดต่อ 

 

จากรูปที่ 2-1 ตัวเลขด้านหลังชื่อโฟลเดอร์ เป็นการแสดงบอกให้ทราบถึงข้อความใหม่ที่ยังไม่ได้อ่าน 

 

รูปที่ 2-1 Mailbox 

 

-       INBOX: กล่องข้อความเข้า ข้อความอีเมลที่เข้ามาใหม่จะถูกเก็บไว้ที่นี่เป็นที่แรก 

-       Drafts: กล่องข้อความร่าง ข้อความอีเมลที่ถูกเก็บบันทึกไว้เป็นข้อความร่าง 

-       Sent Items: กล่องข้อความส่งออก ข้อความอีเมลที่ถูกส่งออกไปจะถูกทำสำเนาเก็บไว้ที่นี่ 

-       Junk: กล่องข้อความ Junk เป็นที่สำหรับเก็บข้อความที่เป็นสแปม  

-       Trash: กล่องข้อความ Trash เป็นที่สำหรับเก็บข้อความที่เป็นขยะ โดยข้อความที่ถูกลบ

แล้วจะถูกส่งมาเก็บไว้ในกล่องข้อความนี้  
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การสร้าง Mailbox / Folder 

ผู้ใช้สามารถสร้าง Mailbox / Folder ได้ตามความต้องการ ดังต่อไปนี้ 

1. คลิก “ ” (เครื่องหมายบวก) ด้านบนซ้ายของเมนู Mail  
 

 

รูปที่ 2-2 เครื่องมือที่ใช้ใน การสร้าง Mailbox ใหม่ 

 

2. คลิกเลือก “Create Folder” 

 

รูปที่ 2-3 แสดงการคลิกเพ่ือ Create Folder 

 

จากนั้นกำหนดชื่อโฟลเดอร์ที่ต้องการสร้าง และคลิก “Save” 

 

รูปที่ 2-4 ใส่ชื่อโฟลเดอร์เพ่ือสร้าง Mailbox ที่ต้องการ 
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3. ในกรณีที่ต้องการสร้าง Sub Folder ให้เลือก Folder Location ที่ต้องการ เช่น สร้าง Sub Folder ชื่อ 
Work ภายใต้ INBOX จากนั้นคลิก “Save” 

 

รูปที่ 2-5 การสร้าง Sub Folder และการเลือก Folder Location ที่ต้องการ 
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บทที่ 3 

การรับ-ส่งอีเมล 
 

กล่องข้อความหลัก คือ โฟลเดอร์ที่ใช้เก็บอีเมลขาเข้า ซึ่งจะประกอบไปด้วยรายการอีเมลทั้งใหม่และเก่า 

ผู้ใช้สามารถเข้าสู่กล่องข้อความหลักได้โดยไปยังเมนู Mail และเลือกโฟลเดอร์ที่ต้องการ 

 

รูปที่ 3-1 แสดงรายการอีเมลทั้งใหม่และเก่า 

 

ในแต่ละอีเมลจะมีสถานะที่บ่งบอกถึงการเปิดอ่านเมล, ความสำคัญของเมล, ไฟล์แนบ และการกระทำต่อ

เมล เช่น การตอบกลับ, การส่งต่อ เป็นต้น ซึ่งมีรายละเอียดดังต่อไปนี้ 

-  แสดงสถานะของอีเมลที่เข้ามาใหม่และยังไม่ได้เปิดอ่านจะเป็นอักษรตัวหนา 

-   แสดงสถานะของเมลที่เปิดอ่านแล้วจะเป็นอักษรตัวบาง 

-    แสดงหัวข้อของเมลที่มีการติด Flag 

                  แสดงสถานะของเมลที่มีไฟล์แนบ 

- Re:    แสดงหัวข้อของเมลที่มีการตอบกลับ 

- Fwd:    แสดงหัวขอ้ของเมลที่มีการส่งต่อ  



9 

 โครงการปรับปรุงระบบจดหมายอิเล็กทรอนิกส์ 
กรมสรรพสามิต (The Excise Department) 

 

 

ระบบ Email สามารถทำการ Reply, Reply All, Forward 

- Reply : ถ้า A เลือก Reply อีเมลตอบกลับจะถูกส่งกลับไปที่ B เพียงคนเดียว 

- Reply All: ถ้า A เลือก Reply All อีเมลตอบกลับจะถูกส่งถึงทั้ง B และ C (หรือใครก็ตามที่อยู่ใน To, 

Cc, Bcc) 

- Forward : ส่งต่อเมลไปให้ผู้อ่ืน โดยมีไฟล์แนบต้นฉบับ 

 

รูปที่ 3-2 แสดงการตอบกลับหรือส่งต่ออีเมล 

 

3.1. การเรียกดูอีเมล (Read E-mail) 
ทำได้โดยการคลิกตรงบรรทัดของรายการข้อความที่ต้องการ  โดยจะมีฟังก์ชันในการกระทำต่ออีเมลที่

เรียกดู ดังนี้ 

-  Delete: ลบข้อความปัจจุบัน 

-  Reply: ตอบกลับข้อความ 

-  Reply to All: ตอบกลับทั้งหมด (รวม Cc ด้วย) 

-  Forward: ส่งต่อไปยัง 

-  Redirect to: ส่งข้อความต่อไปยังผู้อ่ืนที่ต้องการ 

-  Undecoded Message: แสดงข้อความ Header E-mail 

-  Print: ทำการพิมพ์ข้อความท่ีเลือก 

-  Move in to… : ย้าย หรือคัดลอกเมลที่กำลังอ่านอยู่ไปยังโฟลเดอร์ที่เลือก 

-  Toggle Flagged Status: ตั้งค่าข้อความให้ติด Flag 
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-  Toggle Read Status: ทำเครื่องหมายว่ายังไม่ได้อ่าน 

 

รูปที่ 3-3 แสดงการอ่านข้อความอีเมลทั่วไป 

 

การสร้างอีเมลใหม่ (New E-mail) 

ทำได้โดยการคลิก “New Mail” ซึ่งอยู่ด้านบนของหน้าต่าง Mail ในส่วนของการจัดการข้อความ 

 

รูปที่ 3-4 แสดงการสร้างอีเมล 
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ซึ่งจะประกอบด้วยการใช้งาน ดังต่อไปนี้ 

- To    : ระบุชื่อและที่อยู่อีเมลสำหรับผู้รับ 
- Subject    : ระบุหัวเรื่องของข้อความ 

-  Toggle Important  : ระบุระดับความสำคัญของข้อความ  
- Rich formatting  : เรียกใช้ฟังก์ชันการเขียนข้อความแบบ Rich Text เช่น ตัวหนา, ตัว
เข้ม, ตัวเอียง, รูปแบบของตัวอักษร, สีอักษร, การแนบรูปภาพ และการแนบลิงก์ 

-  Formatting  : เรียกใช้งาน Format Style ของข้อความ 

-  Font Color  : เรียกใช้งานเปลี่ยนสีตัวอักษร 

-  Bold   : เรียกใช้งานทำให้ตัวอักษรตัวหนา 

-  Italic   : เรียกใช้งานทำให้ตัวอักษรตัวเอียง 

-  Underline  : เรียกใช้งานตีเส้นใต้ตัวอักษร 

-  Deleted   : เรียกใช้งานขีดเส้นระหว่างกลางตัวอักษร 

-  Align text to the Left : ให้ข้อความชิดซ้าย 

-  Center text  : ให้ข้อความอยู่กึ่งกลาง 

-  Align text to the Right  : ให้ข้อความชิดขวา 

-  Justify Text  : ให้ข้อความชิดทั้งสองด้าน 

-  Unordered List  : ใช้ในการกำหนด หัวข้อ และ รายการ แบบมีลำดับโดยใช้สัญลักษณ์  

-  1. Unordered List  : ใช้ในการกำหนด หัวข้อ และ รายการ แบบมีลำดับโดยใช้ตัวเลข 

-  < Outdent  : ใช้ในการย่อหน้าตัวอักษรให้ไปทางซ้าย 

-  > Indent  : ใช้ในการย่อหน้าตัวอักษรให้ไปทาง 

-  Link   : ใช้ในการแทรกลิงกล์งในจดหมาย 

-  Insert Image…  : ใช้ในการแทรกรูปภาพลงในจดหมาย 

-  Table   : ใช้ในการแทรกตารางลงในจดหมาย 
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รูปที่ 3-5 แสดงการเขียนข้อความอีเมล 
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บทที่ 4 

Web Samoware Function 
 

Web Samoware เป็น HTML5-based Client ที ่สามารถทำงานบนเว็บบราวเซอร์มาตรฐาน เช่น 

Internet Explorer, Mozilla Firefox, Google Chrome ฯ ซึ่งใช้เทคโนโลยี HTML5 ทำให้การเรียกใช้งานเป็นไป

อย่างราบรื่น เสมือนว่ากำลังใช้งานโปรแกรมบนเครื่องของตัวเองอยู่ ใน Web Samoware จะประกอบไปด้วย 

ฟังกัชันระบบอีเมล, สมุดรายชื่อผู้ติดต่อ (Contacts) ฟังก์ชันสําหรับการสําหรับการทํางานร่วมกันในองค์กร เช่น 

ตารางนัดหมาย (Calendar), ระบบโทรศัพท์ (Call), และฟังก์ชันเสริม พิเศษอ่ืนๆ เช่น ไฟล์ (Files) 

 

4.1. สมุดรายชื่อผู้ติดต่อ (Contacts) 
ผู้ใช้สามารถเข้าสู่รายชื่อผู้ติดต่อได้ โดยคลิกเมนู “Contact” ที่เมนูด้านซ้ายมือ 

 

รูปที่ 4-1 แสดงเมนูรายชื่อผู้ติดต่อ (Contacts) 
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4.2. การสร้างสมุดรายชื่อผู้ติดต่อใหม ่
การสร้างสมุดรายชื่อผู้ติดต่อใหม่ สามารถทำได้โดยคลิกเครื่องหมายบวก ตรงด้านขวามือในส่วนของ

ฟังก์ชัน Contacts และเลือก “New Contact” 

 

รูปที่ 4-2 แสดงการสร้างรายชื่อผู้ติดต่อ (Contacts) 

 

ซึ่งในหน้าการเพ่ิมรายชื่อผู้ติดต่อใหม่ จะประกอบไปด้วย 

- File As  : ชื่อผู้ติดต่อใหม่ 
- Title  : คำนำหน้า 
- First Name : ชื่อจริง 
- Middle Name : ชื่อกลาง 
- Last Name : ชื่อนามสกุล 
- E-MAIL  : อีเมล ซึ่งสามารถเลือกประเภทให้เป็น Home, Work ได ้
- TELEPHONE : เบอร์ติดต่อ ซึ่งสามารถเลือกประเภทให้เป็น Home, Work, Cell, Fax ได ้
- ADDRESS  : ที่อยู่ของผู้ติดต่อใหม่ ซึ่งสามารถเลือกประเภทให้เป็น Home, Work ได ้
เป็นต้น ฯลฯ  

 



15 

 โครงการปรับปรุงระบบจดหมายอิเล็กทรอนิกส์ 
กรมสรรพสามิต (The Excise Department) 

 

 

 

รูปที่ 4-3 แสดงรายละเอียดการเพิ่มรายชื่อผู้ติดต่อ (Contacts) 

 

4.3. การสร้างกลุ่มรายชื่อผู้ติดต่อใหม ่
การสร้างกลุ่มรายชื่อผู้ติดต่อใหม่สามารถทำได้โดยคลิกเครื่องหมายบวก ตรงด้านขวามือในส่วนของ

ฟังก์ชัน Contacts และเลือก “New Contact Group” 

 

รูปที่ 4-4 แสดงการสร้างกลุ่มรายชื่อผู้ติดต่อ (Contact Group) 
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โดยใส่กลุ่มรายชื่อผู้ติดต่อที่ต้องการในช่อง “Name” พร้อมคำอธิบายเพิ่มเติมที่ช่อง “Note” จากนั้น

กรอกรายชื่อผู้ติดต่อที่ต้องการ หรือคลิกเลือกรายชื่อผู้ติดต่อที่มีอยู่ เมื่อเพิ่มรายชื่อที่ต้องการเรียบร้อยแล้วคลิก 

“Save” และคลิกเครื่องหมายกากบาทเพ่ือปิดหน้าต่างการเพ่ิมกลุ่มรายชื่อผู้ติดต่อ 

 

รูปที่ 4-5 แสดงรายละเอียดการเพิ่มกลุ่มรายชื่อผู้ติดต่อ (Contact Group) 

 

 

รูปที่ 4-6 แสดงรายละเอียดการเพิ่มกลุ่มรายชื่อผู้ติดต่อ (Contact Group) 

 

4.4. การใช้งานปฏิทิน 
ปฏิทินและตารางนัดหมาย (Calendar and Schedule) สำหรับปฏิทินและตารางนัดหมายแล้ว

เปรียบเสมือนบันทึกช่วยจำในการจัดตารางเวลาทั ้ง ในการทำงานและการบริหารทรัพยากรให้ได้อย่างมี

ประสิทธิภาพ 
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สามารถทำได้โดยการคลิกท่ีปุ่ม + ใน “Calendar” ซึ่งอยู่ใน Menu Bar ด้านบนของ หน้าจอ Web mail 

 และเมื่อคลิกแล้วก็จะเข้าสู่กล่องข้อความปฏิทินและตารางนัดหมายหลัก ซึ่งสามารถ

เลือกมุมมองของตารางนัดหมายเป็นวัน, สัปดาห์, เดือน, ตารางเวลา หรือโฟลเดอร์ 

 
รูปที่ 4-7 แสดงรายละเอียดการใช้งานปฏิทิน 

 

การสร้างปฏิทินและตารางนัดหมายคลิกที่ไอคอน + ของฟังก์ชัน Calendar เพ่ือเข้าสู่การสร้างตารางนัดหมาย 

 
รูปที่ 4-8 แสดงรายละเอียดตารางนัดหมาย 
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4.5. การนัดหมาย การเชิญประชุม และการเตือนความจำโดยใช้ปฏิทิน 

การสร้างปฏิทินและตารางนัดหมายคลิกที่ไอคอน + กรอกรายละเอียด และทำการคลิกไอคอน  

เพ่ิมผู้ประชุม และทำการ Save 

 

รูปที่ 4-9 แสดงรายละเอียดตารางเชิญประชุม 

 

4.6. การเตือนความจำโดยใช้ปฏิทิน 
การสร้างการเตือนความจำโดยใช้ปฏิทิน คลิกที่ไอคอน +  กรอกรายละเอียด ที่ต้องการแจ้งเตือน และ

กำหนดการแจ้งเตือนก่อนการประชุมในส่วน Alarm เมื่อดำเนินการสร้างเรียบร้อยแล้วให้ทำการคลิก Save 

 
รูปที่ 4-10 แสดงรายละเอียดการเตือนความจำโดยใช้ปฏิทิน 
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Subject ระบุหัวเรื่องสําหรับการนัดหมาย 

Attendees ระบุผู้รับหรือผู้เข้าร่วมในตารางนัดหมายหลัก 

Starts วันที่เริ่มการนัดหมาย 

Ends วันที่สิ้นนสุดการนัดหมาย 

Where สถานที่สําหรับนัดหมาย 

Description คำอธิบายเพ่ิมเติม 

Status สถานะของจดหมาย 

Alarm  การแจ้งเตือน 
 

4.7. การใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร 

เป็นส่วนการจัดการไฟล์ และแสดงไฟล์ที่เก็บในระบบสามารถอัพโหลดได้โดยคลิกที่ปุ่ม  ซึ่งอยู่ใน

เมนูด้านบนของหน้าจอแล้วเลือก Files 

 

รูปที่ 4-11 แสดงรายละเอียดการใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร 
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โดยมีฟังก์ชั่นในเมนู File ดังนี้ 

 
 

-  Upload  : ทำการอัพโหลดไฟล์จากในเครื่องคอมพิวเตอร์เข้าสู่ Web Mail 

-  Download  : ทำการดาวน์โหลดไฟล์ที่มีอยู่ในรายการลงในเครื่องคอมพิวเตอร์ 

-  Share link  : ทำการแชร์ไฟล์ ผ่านลิงก์ให้เพ่ือนๆ ได้ 

-  E-mail Link : ทำการแชร์ไฟล์ ผ่านลิงก์แล้วส่งเป็นอีเมลให้ผู้อ่ืนได้ 

-  Move or Copy : ทำการย้าย หรือทำการ Copy ไปยังโฟลเดอร์อื่น 

-  Delete  : ทำการลบไฟล์ที่เลือกไว้ 

 

นอกจากนี้ผู้ใช้ยังสามารถกำหนดสิทธิ์ให้ผู้ใช้อ่ืนสามารถเข้าดูหรือเพ่ิมเติมในแต่ละไฟล์ได้ โดยการคลิกขวา

ที่ไฟล์ แล้วเลือก Access granted to… 

 

รูปที่ 4-12 แสดงรายละเอียดการกำหนดสิทธิ์ 
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4.8. การแชร์โฟลเดอร์ส่วนตัว 
ผู้ใช้งานสามารถกำหนด Share Folder ให้ผู้อื่นได้เลือกโฟลเดอร์ที่ต้องการแชร์ และคลิก “Edit” 

 
รูปที่ 4-13 แสดงรายละเอียดการแชร์โฟลเดอร์ส่วนตัว 

 

กรอกอีเมลแอดเดรสที่ต้องการแชร์ ในช่อง Access Control List โดยสามารถกำหนดสิทธิ์ในการเข้าถึง 

เ ช ่ น  Read, Write, Admin หร ื อ  Custom (Lookup, Select, Seen, Flags, Insert, Create, Delete แ ล ะ 

Admin) จากนั้นคลิก “Save” 

 
รูปที่ 4-14 แสดงรายละเอียดการแชร์โฟลเดอร์ส่วนตัว 
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4.9. การรับ Share Folders จากผู้อื่น 
หากผู ้ใช้งานได้ร ับสิทธิ ์ในการ Share folder จะได้รับจดหมาย Access Control List จากนั้นคลิก 

“Subscribe” 

 
รูปที่ 4-15 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น 

 

ระบบจะส่งไปยังหน้าต่าง Folder Subscription จากนั้นคลิก “Save” 

 
รูปที่ 4-16 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น 
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4.10. ระบบเมลจะแสดงโฟลเดอร์ที่ได้รับการ Share 

 
รูปที่ 4-17 แสดงรายละเอียดการรับ Share Folders จากผู้อื่น 
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บทที่ 5 

การตั้งค่าต่างๆ ใน Web Samoware 
 

การตั้งค่าต่างๆ ในระบบ Web Samoware สามารถทำได้โดยการคลิกท่ีเมนู “Preferences” ที่เมนูด้านซ้ายมือ 

 

รูปที่ 5-1 การตั้งค่าต่างๆ ในระบบ Web Samoware 

 

5.1. General 
ในส่วนนี ้ จะเป็นการตั ้งค่าทั ่วไปของWeb mail โดยแบ่งออกเป็น Password, Devices, Sounds, 

Access Control List 
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รูปที่ 5-1-1 แสดงการเมนูการตั้งค่า ส่วน General 

 

สำหรับการตั้งค่าทั่วไปของระบบ Web Samoware ผู้ใช้สามารถเลือกตั้งค่า ภาษา (Language), โซน

เวลา (Time Zone), Auto logout, พื้นที่การใช้งานอีเมล (Quota), เวอร์ชั่นระบบอีเมล, สกิน (Skin), ช่วยเหลือ 

(Help)  

 

รูปที่ 5-1-2 แสดงการตั้งค่าเมนู General 

 

5.1.1. Password 

ผู้ใช้งานสามารถเปลี่ยนรหัสผ่านเองได้โดย ใส่รหัสผ่านเดิม (Current Password) และรหัสผ่านใหม่ 

(New Password, Reenter Password) และคลิก “Apply”  
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รูปที่ 5-1-3 แสดงเมนูการเปลี่ยนรหัสผ่านอีเมล 

 

5.1.2. Search 

ระบบสามารถค้นหาข้อความ ได้ทั้งแบบภาษาไทยและภาษาอังกฤษ โดยการค้นหาจะแบ่งออกเป็น 

Email, Calendar หรือ Contact 

▪ วิธีการ Search Email สามารถทำการค้นหา ภาษาไทยและภาษาอังกฤษ 

    

รูปที่ 5-1-4 แสดงวิธีการ Search Email 
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▪ ตัวอย่าง ทดสอบค้นหาภาษาอังกฤษ 

 

รูปที่ 5-1-5 แสดงวิธีการ ทดสอบค้นหาภาษาอังกฤษ 

 

▪ ตัวอย่าง ทดสอบค้นหาภาษาไทย 

 
รูปที่ 5-1-6 แสดงวิธีการ ทดสอบค้นหาภาษาไทย 

 

▪ สามารถ Search ขั้นสูงที่อนุญาตให้ค้นหาพารามิเตอร์เฉพาะ เช่น “From”, “Subject” และตามช่วง

วันที่กำหนด 
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รูปที่ 5-1-7 แสดงวิธีการสามารถ Search ขั้นสูง 

 

▪ ตัวอย่าง การค้นหาด้วย From 

 

รูปที่ 5-1-8 แสดงการค้นหาด้วย From 
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รูปที่ 5-1-9 แสดงการค้นหาด้วย From 

 

▪ ตัวอย่าง การค้นหาด้วย Subject 

 

รูปที่ 5-1-10 แสดงการค้นหาด้วย Subject 
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รูปที่ 5-1-11 แสดงการค้นหาด้วย Subject 

 

▪ ตัวอย่าง การค้นหาด้วย Cc 

 

รูปที่ 5-1-12 แสดงการค้นหาด้วย Cc 
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รูปที่ 5-1-13 แสดงการค้นหาด้วย Cc 

 

▪ ตัวอย่าง การค้นหาด้วย Wildcard 

 
รูปที่ 5-1-14 แสดงการค้นหาด้วย Wildcard 
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รูปที่ 5-1-15 แสดงการค้นหาด้วย Wildcard 

 

▪ วิธีการ Search Contact 

 

รูปที่ 5-1-16 แสดงวิธีการ Search Contact 

 

▪ buddies รายชื่อกลุ่ม หากมีคำยืนยันคำขอเป็นเพ่ือนกัน ทั้งสองฝ่ายสามารถเห็นทำใช้งานของกันและกัน 

▪ contact รายชื่อกลุ่มท่ีติดต่อใหม่ 

▪ My domain รายชื่อผู้ติดต่อภายในโดเมน 
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▪ วิธีการ Search ไฟล์แนบ 
กรณีค้นหาเป็นไฟล์แนบจะต้องทราบชื่อไฟล์ สามารถใส่บางค่าเพ่ือค้นหาได้ 

 

รูปที่ 5-1-17 แสดงวิธีการ Search ไฟล์แนบ 

 

5.1.3. Two-Factor Authentication 

2FA เป็นการล็อกอินขั้นที่ 2 หลังจากล็อกอินด้วยรหัสผ่านตามปกติ จะมีการยืนยันผ่านข้อความ SMS 

บนโทรศัพท์สมาร์ทโฟน เพ่ือป้อนรหัสให้ตรงกัน และยืนยันตัวตน 

- วิธีการตั้งค่าการใช้งาน Two-Factor Authentication โดยการส่งรหัสไปยังทางอีเมล 

สามารถกำหนด Current Password และทำการกรอก Forgotten Password Recovery ใส่รายละเอียด

อีเมลที่ต้องการส่งไปเพื่อสามารถส่ง Confirmation code เพ่ือนำมากรอกเข้าระบบ 

 

รูปที่ 5-1-18 แสดงการตั้งค่าการใช้งาน Two-Factor Authentication 

 

5.1.4. Devices 

เป็นเมนูแสดงรายละเอียดการเข้าใช้งานระบบอีเมล โดยระบุ Protocol, Login time, Login address, 

Browser, Client name และ Platform 
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รูปที่ 5-1-19 แสดงรายละเอียดการเข้าใช้งานระบบอีเมล 

 

5.1.5. Sounds 

ผู้ใช้งานสามารถเลือกเปิด/ปิดเสียงในระบบได้ผ่านเมนูนี้ 

 

รูปที่ 5-1-20 แสดงเมนูการตั้งเปิด/ปิดเสียงในระบบ 

 

5.1.6. Access Control List 

ผู้ใช้งานสามารถให้สิทธิ์ผู้ใช้งานอื่นในระบบ ในการเข้าถึงข้อมูลได้โดย 
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รูปที่ 5-1-21 แสดงการตั้งค่าการเข้าถึงข้อมูล 

 

Identifier ใส่ชื่อ account ที่ต้องการใหส้ิทธ์ิในการเข้าถึงข้อมูล 

Delegate ให้สิทธ์ิการเข้าถึงข้อมูล และสร้างโฟลเดอร์อีเมลย่อยได้ 

Call Control ให้สิทธ์ิการจัดการสายเรียกเข้า (Call) 

Admin ให้สิทธ์ิการเข้าจดัการข้อมลูทั้งหมด 

Create ให้สิทธ์ิในการสร้างโฟลเดอรไ์ด ้

 

5.2. Mail 
ในส่วนนี้เป็นการตั้งค่าเกี่ยวกับเมล โดยแบ่งออกเป็น Rules, Trash Management, Remote POP, 

Vacation message, Identities, Copy All Mail to และ Secure Mail การตั ้งค่าเมลคือ การตั ้งค่าต่างๆ ที่

เกี่ยวกับจดหมาย ซึ่งสามารถกำหนดรายละเอียดต่างๆ ได้ดังนี้  

 

รูปที่ 5-2-1 แสดงการตั้งค่าเมล 
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- Notify about new mail : การแจ้งเตือนเมื่อมีเมลใหม่ 
- Auto-save Every : การตั้งค่าเวลาในการบันทึกอัตโนมัติ 
- Use HTML compose : ใช้รปูแบบ HTML ในการเขียนจดหมายใหม่ 
- Save recent addresses : บันทึกอีเมลที่มีการติดต่อ 
- Show number of messages in mailbox : แสดงจำนวนข้อความใน mailbox 
- Automatically notify when read : ส่งเมลแจ้งเตือนเมื่อผู้รับอ่านเมล 
- Automatically notify when delivered : ส่งเมลแจ้งเตือนเมื่อปลายทางได้รับอีเมล 
- Send Read Receipts : ส่งข้อความตอบกลับ เมื่อมีการอ่านข้อความ 
- Mark As Read After : ทำสัญลักษณ์เมื่อมีการอ่านจดหมาย 
- Store Drafts in : ตั้งค่าโฟลเดอร์เก็บข้อความร่าง 
- Save Sent Messages in : ตั้งค่าโฟลเดอร์เก็บข้อความส่งออก 
- Messages page size : จำนวนข้อความที่แสดงต่อหน้า 
- Display Links : ตั้งค่าแสดงลิงก์ 
- Signature : ลายเซ็นแนบท้ายข้อความ 
- Automatically Select Message : เลือกข้อความอัตโนมัติ 
- Forward messages inline : ตอบกลับข้อความในบรรทัด 
- Hide images : ซ่อนรูปภาพ 
- Multi-compost mode : ส่งข้อความแบบ Multi 
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5.3. การกำหนดข้อความลงท้ายอีเมล (Signature) 
การกำหนดลายเซ ็นสำหร ับแนบท้ายอ ี เมลท ี ่ส ่งออกไปหาผู ้อ ื ่น สามารถทำได ้โดยคลิกที ่ปุ่ม 

“Preferences” ใน Menu Bar จากน ั ้นเล ือกแท ็บ Mail ใน Sub menu เล ื ่อนลงข ้างล ่างจะเจอห ัวข้อ 

“Signature” ทำการเพิ่มรายละเอียดข้อความที่ต้องการ แล้วทำการบันทึก โดยคลิกที่ปุ่ม Apply 

 

รูปที่ 5-3-1 แสดงการตั้งค่าเมล 
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▪ วิธีการเปลี่ยน Compose ใน Signature 

 

รูปที่ 5-3-2 แสดงการวิธีการเปลี่ยน Compose ใน Signature 
 

5.4. วิธีการสร้าง Message Tags 

 

รูปที่ 5-4-1 แสดงการวิธีการสร้าง Message Tags 

 

- ทำการสร้าง Rule เข้าไปที่ Preferences > Rules  

- From is xxx*  

- Action Mark Flagged,$Label1  
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รูปที่ 5-4-2 แสดงการวิธีการสร้างMessage Tags 

 

▪ ผลทดสอบ 

 

รูปที่ 5-4-3 แสดงการวิธีการสร้างMessage Tags 

 

5.4.1. Rules 

เป็นการสร้างกฎเกณฑ์เพื่อใช้ควบคุมและจัดการข้อความเข้าสู่ระบบ เพื่อให้สามารถใช้งานได้ตามความ

ต้องการ ซึ่งสามารถทำได้โดยคลิกเครื่องหมายบวก “Make Rule” จากนั้นตั้งชื่อ Rule ที่ต้องการ (Name) พร้อม

ใส่คำอธิบายเพิ่มเติม (Description) 
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รูปที่ 5-4-4 แสดงการตั้งชื่อกฎเกณฑ์ (Rules) 

 

1) Data เป็นการกำหนดเงื่อนไขของข้อมูลที่ปรากฎใน message ใดๆ 

Data 

From จาก(ผู้ส่ง) 

Sender ผู้ส่ง 

Return-Path E-Mail Address ที่ส่งกลับ 

To ถึง (ผู้รับ) 

Cc สำเนา (ผูร้ับ) 

Any To or Cc ถึงทุกคน หรือ สำเนา (ผู้รับ) 

Each To or Cc ถึงใครคนใดคนหนึ่ง หรือ สำเนา (ผู้รับ) 

Reply-To ตอบกลับถึง (ผู้รับ) 

‘From’ Name จาก (ผู้ส่ง) ช่ือ 

Subject หัวเรื่อง 

Message-ID รหัส Message-ID 

Message Size ขนาดของ Message 

Time Of Day เวลาของ Message 

Current Date วันปัจจุบัน (Monday, Tuesday, Wednesday, etc) 

Current Day วันท่ีปัจจุบัน 

Human Generated ถูกสร้างโดยบุคคล (ไม่ใช่คอมพิวเตอร์) 

Header Filed ข้อความส่วนหัว Message 

Any Recipient ผู้รับคนใดคนหนึ่ง 

Each Recipient ผู้รับคนใด 

Existing Mailbox Mailbox ที่ถูกสร้างขึ้นแล้ว 
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Data 

Source ข้อมูลต้นทาง 

 

2) Action เป็นการกำหนดให้ระบบทำตามเงื่อนไข 
Action Parameter 

Store in เก็บข้อมูลใน  ช่ือ Mailbox 

Store Encrypted in เก็บข้อมูลที่ได้ถูกเข้ารหัสใน ช่ือ Mailbox 

Mark ทำสัญลักษณ ์  

Add Header เพิ่มหัวข้อมูล ข้อมูล Header 

Tag Subject เพิ่มข้อความในหัวเรื่อง ข้อความ 

Reject with ปฏิเสธด้วย ข้อความ 

Discard ละเว้นการทำงานใดๆ  

Stop Processing หยุดการประมวลผล  

Redirect To Redirect ไปยัง ผู้รับ 

Forward To Forward ไปยัง ผู้รับ 

Reply with ตอบกลับด้วย ข้อความ 

 

ทำการสร้างเงื่อนไขที่ต้องการ ซึ่งสามารถกำหนดได้เอง โดยคลิกที่ “Expert Mode” หรือสร้าง Rule 

จากข้ันตอนของระบบ โดยคลิก “Next” เมื่อกำหนด Rule เรียบร้อยแล้วคลิก “Save Rule” เพ่ือใช้งาน 

 

รูปที่ 5-4-5 แสดงการตั้งค่ากฎเกณฑ์ (Rules) แบบ Expert Mode 
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Add Rule ใส่ชื่อ Rule  

Delete Marked ลบ Rule ที่เลือก 

Priority ลำดับความสำคญั หรือ ยกเลิกการใช้ช่ัวคราว 

Name แสดงช่ือของ Rule ที่ได้สร้างไว้แลว้ 

Edit ปรับแต่ง Rule 

 

 

รูปที่ 5-4-6 แสดงการตั้งค่ากฎเกณฑ์ (Rules) แบบ Expert Mode 

 

Comment ไว้สำหรับใส่เพื่อความเข้าใจ 

Data กำหนดเงื่อนไข 

Operation ทำตามเง่ือนไข 

Parameter (Data) ส่วนท่ีต้องการ 

Action จากเงื่อนไข (Data) ให้ปฏิบัติ 

Parameter (Action) ส่วนท่ีต้องการตาม Action 
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ตัวอย่างการสร้าง Rules : 

Ex1 – การ Move to Folder ที่กำหนด 

 

รูปที่ 5-4-7 แสดงการทำ Rule ตามตัวอย่างท่ี 1 

 

Ex2 - การละเว้น (ไม่รับ) เมลที่ไม่ถูกรูปแบบ 

 

รูปที่ 5-4-8 แสดงการทำ Rule ตามตัวอย่างท่ี 2 
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Ex3 - การละเว้น (ไม่รับ) เมลที่ให้ส่งกลับไปยัง info@domain.com  

 

รูปที่ 5-4-9 แสดงการทำ Rule ตามตัวอย่างท่ี 3 

 

Ex4 - กรณีท่ีเมลที่ส่งมาหลังจาก 8:15 am ให้ Redirect ไปยัง info@domain.com 

 
รูปที่ 5-4-10 แสดงการทำ Rule ตามตัวอย่างท่ี 4 

 

5.4.2. Trash Management 

Trash Management เป็นการตั้งค่าจดหมาย ที่ถูกลบและจดหมายขยะ โดยมีรายละเอียดการตั้งค่าดังนี้ 

mailto:info@domain.com
mailto:info@domain.com
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รูปที่ 5-4-11 แสดงการกำหนดจดหมายที่ไม่ต้องการ และจดหมายขยะ 

 

• Trash Management  

 Message Delete Method เลือกวิธีการลบข้อความ 

- ทำสัญลักษณ ์

- ย้ายไปไว้ในถังขยะ 

- ลบทันที 

Trash Folder ย้ายข้อความที่ถูกลบไปยังโฟลเดอร์ 

Keep Message Received Time เก็บเวลารับข้อความ เมื่อย้ายไปโฟลเดอร์ที่กำหนดไว ้

On Logout Remove from Trash if 

Older than 

ลบข้อความที่ถูกลบที่เก่ากว่า เมื่อออกจากระบบ 

 

• Junk Mail Control 

Junk Folder ย้ายข้อความขยะไปยังโฟลเดอร ์

On Logout Remove from Junk if Older 

than 

ลบข้อความขยะทีเ่ก่ากว่า เมื่อออกจากระบบ 
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5.4.3. Remote Poll 

เป็นการดึงอีเมลจาก Account อื่นๆ มารวมเก็บไว้ที่เดียวกัน โดยใส่รายละเอียดอีเมล (E-mail), Server 

Name และรายละเอียดการตั้งค่าต่าง ๆ ตามต้องการ และคลิก “Add” 

 

รูปที่ 5-4-12 แสดงการตั้งค่า Remote POP 

 

• การตั้งค่า POP 

1. Users > Domain > <ชื่อโดเมนที่ต้องการ> > Objects > <User ที่ต้องการ> > Mail > 

Remote Poll ตามรูปด้านล่าง 

 

รูปที่ 5-4-13 แสดงการตั้งค่า Remote POP 

 

ทำการกรอกข้อมูลตามด้านล่าง และกด Update  
- Name ชื่อ Policy ที่ต้องการตั้ง 

- Poll Evert ระยะเวลาที่ต้องให้ Server Sync ข้อมูล 

- Account ชื่อ Account ที่ต้องการ Sync 
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- At Host ชื่อ Host Mail ต้นทางที่ต้องการเชื่อต่อ 

- Leave เมื่อทำการลบ email จะไม่ลบ email ที่ต้นทาง 

 

 

รูปที่ 5-4-14 แสดงการตั้งค่า Remote POP 

 

2. เมื่อตั้งค่าเรียบร้อยแล้วจะได้รูปตามด้านล่าง 

เปิด Browser ระบุ https://mail.excise.go.th > Mail > Remote Poll 

 

รูปที่ 5-4-15 แสดงการตั้งค่า Remote POP 

 

• การตั้งค่า IMAP 

1. Users > Domain > <ชื่อโดเมนที่ต้องการ> > Objects > <User ที่ต้องการ> > Mail > 

Remote Poll ตามรูปด้านล่าง 
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รูปที่ 5-4-16 แสดงการตั้งค่า IMAP 

 

2. ทำการกรอกข้อมูลตามด้านล่าง และกด Update  

- Name ชื่อ Policy ที่ต้องการตั้ง 

- Poll Evert ระยะเวลาที่ต้องให้ Server Sync ข้อมูล 

- Account ชื่อ Account ที่ต้องการ Sync 

- At Host ชื่อ Host Mail ต้นทางที่ต้องการเชื่อมต่อ 

 

รูปที่ 5-4-17 แสดงการกรอกข้อมูล 
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3. เมื่อตั้งค่าเรียบร้อยแล้วจะได้รูปตามด้านล่าง 

เปิด Browser ระบุ https://mail.excise.go.th > Mail > Remote Poll > IMAP 

 

รูปที่ 5-4-18 แสดงเมื่อตั้งค่าเรียบร้อยแล้ว 

 

5.4.4. จัดการอีเมลขยะ 

เป็นการกําหนดการกระทําของแต่ละอีเมลที่มีความเป็นไปได้ว่าจะเป็นอีเมลขยะสูง, ปานกลาง หรือตํ่า ซึ่ง

ทําได้โดยการคลิกท่ีปุ่ม ‚Junk Mail Control และคลิกที่ปุ่ม เพ่ือ อัพเดทการตั้งค่า 

 

รูปที่ 5-4-19 รูปแสดงการจัดการอีเมลขยะ 

 

5.4.5. Vacation Message 

เป็นการสร้างข้อความตอบกลับอัตโนมัติกรณีที่ไม่สามารถตอบกลับข้อความได้หรืออยู่ในช่วงลาพักงาน  

(Vacation) โดยสามารถเปิดใช้โดย Enable “Vacation Message enabled” 
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รูปที่ 5-4-20 แสดงการเปิดใช้งาน Vacation Message 

 

ทำการกำหนดวันเริ่มใช้งาน (Starts) และวันสิ้นสุด (Ends) พร้อมระบุวันที่ จากนั้นกรอกข้อความตอบ

กลับอัตโนมัติที่ต้องการ (Text) หากต้องการให้มีการแจ้งเตือนไปยังบุคคลอื่นๆ ให้ Enable Notify และกรอก

อีเมลที่ต้องการ จากนั้นคลิก “Apply” เพื่ออัพเดทการตั้งค่า โดยแนะนำให้คลิก “Clear” ทุกครั้งที่มีการตั้งค่า 

Vacation Message เพ่ือลบข้อมูลอีเมลที่มีการส่งถึงแล้ว 

 

รูปที่ 5-4-21 แสดงการตั้งค่าใช้งาน Vacation Message 
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5.4.6. Identities 

เป็นการกำหนดชื่อ Account เพื่อใช้งาน เช่น ไว้ใช้ในการส่งอีเมล เมื่อกำหนดค่าเรียบร้อยแล้ว ให้คลิก 

“Save” และ “Apply” เพ่ืออัพเดทการตั้งค่า 

 

รูปที่ 5-4-22 แสดงการตั้งค่า Identities 

 

5.4.7. Copy All Mail to 

เป็นการตั้งค่าคัดลอกอีเมลไปยัง Account ที่ต้องการ โดยสามารถเปิดใช้โดย Enable “Copy All Mail 

To” 

 

รูปที่ 5-4-23 แสดงการเปิดใช้งาน Copy All Mail To 
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รูปที่ 5-4-24 แสดงการตั้งค่าใช้งาน Copy All Mail To 

 

E-mail คัดลอกข้อความไปยังอีเมล 

Keep the Original เก็บข้อความไว ้

Do not Copy Automatic Messages ไม่ต้องคัดลอกข้อความส่งอัตโนมัต ิ

Action เลือกวิธีคัดลอกข้อความ 

- ส่งด้วยชื่อผู้ตั้งค่า 

- เก็บช่ือผู้ส่ง 

- เก็บช่ือผู้ส่ง และผูร้ับ 

 

5.4.8. การใช้งาน Secure Mail (S/MIME) 

การเข้ารหัสคีย์ใช้สำหรับลงลายมือชื่ออิเล็กทรอนิกส์ (ลายเซ็นดิจิตอล) และการเข้ารหัสอีเมล เพื่อเพ่ิม

ระดับความปลอดภัย ช่วยปกป้องข้อมูลและรักษาข้อมูลที่เป็นความลับให้กับ Account ผู้ใช้งาน  
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รูปที่ 5-4-25 แสดงการตั้งค่าใช้งาน Secure Mail 

 

 

รูปที่ 5-4-26 แสดงตัวอย่างได้รับอีเมลที่ถูกตั้งค่าโดย Secure Mail 

 

5.4.9. Contact 

เป็นการเพิ่มที่อยู่การติดต่อ โดยระบุชื ่อที่อยู่ไดเรกทอรีและฐานการค้นหา (ค้นหา DN) จากนั้นคลิก 

“Apply” 
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รูปที่ 5-4-27 แสดงการตั้งค่า Directory Address Books 

 

5.4.10. การตั้งค่าปฏิทิน (Calendar) 

เป็นการตั้งค่าปฏิทินในระบบ Debut UC ซึ่งสามารถกําหนดปฏิทินหลัก, กําหนดการแบ่งเวลาเป็นคาบ

ของปฏิทิน, กําหนดมุมมองของตารางในปฏิทิน, กําหนดวันเริ่มในสัปดาห์, กําหนดชั่วโมงการทํางาน, กําหนด

จํานวนวันของข้อมูลสถานะว่าง/ไม่ว่างที่จะปรากฎบนอินเทอร์เน็ตจากนั้นจึงทําการอัพเดทค่าที่เปลี่ยนแปลง 

 

รปูที่ 5-4-28 แสดงการเข้าตั้งค่าปฏิทิน (Calendar) 
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5.5. การใช้งานปฏิทิน 
5.5.1. ปฏิทินและตารางนัดหมาย (Calendar and Schedule) 

สำหรับปฏิทินและตารางนัดหมายแล้วเปรียบเสมือนบันทึกช่วยจำในการจัดตารางเวลาทั้ง ในการทำงาน

และการบริหารทรัพยากรให้ได้อย่างมีประสิทธิภาพ 

- สามารถทำได้โดยการคลิกที่ปุ่ม + ใน “Calendar” ซึ่งอยู่ใน Menu Bar ด้านบนของหน้าจอ 

Web mail  และเมื่อคลิกแล้วก็จะเข้าสู่กล่องข้อความปฏิทินและตารางนัดหมายหลัก ซึ่ง

สามารถเลือกมุมมองของตารางนัดหมายเป็นวัน, สัปดาห์, เดือน, ตารางเวลา หรือโฟลเดอร์ 

 

 

รปูที ่5-5-1 แสดงการสร้างปฏิทิน (Calendar) 

 

การสร้างปฏิทินและตารางนัดหมายคลิกที่ไอคอน + ของฟังก์ชัน Calendar เพ่ือเข้าสู่การสร้างตารางนัดหมาย 

 

รปูที่ 5-5-2 แสดงการสร้างปฏิทิน (Calendar) 
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เมื่อดำเนินการสร้างเรียบร้อยแล้ว จะได้ตัวอย่างตามด้านล่าง 

 

รปูที่ 5-5-3 แสดงผลลัพธ์ (Calendar) 

 

5.5.2. การนัดหมาย การเชิญประชุม และการเตือนความจำโดยใช้ปฏิทิน 

การสร้างปฏิทินและตารางนัดหมายคลิกที่ไอคอน + กรอกรายละเอียด และทำการคลิกไอคอน  

เพ่ิมผู้ประชุม และทำการ Save 

 
รปูที่ 5-5-4 แสดงการสร้างปฏิทิน (Calendar) 

 

เมื่อดำเนินการสร้างเรียบร้อยแล้ว จะได้ตัวอย่างตามด้านล่าง 
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รปูที ่5-5-5 แสดงการสร้างปฏิทิน (Calendar) 

 

5.5.3. การเตือนความจำโดยใช้ปฏิทิน 

การสร้างการเตือนความจำโดยใช้ปฏิทิน คลิกที่ไอคอน + กรอกรายละเอียด ที่ต้องการแจ้งเตือน และ

กำหนดการแจ้งเตือนก่อนการประชุมในส่วน Alarm เมื่อดำเนินการสร้างเรียบร้อยแล้วให้ทำการคลิก Save 

 
รปูที่ 5-5-6 แสดงการสร้างปฏิทิน (Calendar) 
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5.6. การใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร 

เป็นส่วนการจัดการไฟล์ และแสดงไฟล์ที่เก็บในระบบสามารถอัพโหลดได้โดยคลิกที่ปุ่ม  ซึ่งอยู่ใน

เมนูด้านบนของหน้าจอแล้วเลือก Files 

 
รูปที่ 5-6 การใช้กระเป๋าเอกสารในการจัดเก็บเอกสาร 

 

Private เป็น folder สำหรับเก็บข้อมูลส่วนตัว 

Paucal เป็น virtual folder ที่ระบบสร้างขึ้น ข้อมูลในโฟลเดอร์นี้ จะเป็น virtual file ที่สร้างจากข้อมูล

ของผู้ใช้ โดยมีฟังก์ชั่นในเมนู File ดังนี้ 

 
 

-  Upload: ทำการอัพโหลดไฟล์จากในเครื่องคอมพิวเตอร์เข้าสู่ Web Mail 

-  Download: ทำการดาวน์โหลดไฟล์ที่มีอยู่ในรายการลงในเครื่องคอมพิวเตอร์ 

-  Share link: ทำการแชร์ไฟล์ ผ่านลิงกใ์ห้เพ่ือนๆ ได้ 

-  E-mail Link: ทำการแชร์ไฟล์ ผ่านลิงกแ์ล้วส่งเป็นอีเมลให้ผู้อื่นได้ 

-  Move or Copy: ทำการย้าย หรือทำการ Copy ไปยังโฟลเดอร์อ่ืน 

-  Delete: ทำการลบไฟล์ที่เลือกไว้ 
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นอกจากนีผู้้ใช้ยังสามารถกำหนดสิทธิ์ให้ผู้ใช้อ่ืนสามารถเข้าดูหรือเพ่ิมเติมในแต่ละไฟล์ได้ โดยการคลิกขวา

ที่ไฟล์ แล้วเลือก Access granted to… 

 

รปูที่ 5-6-1 แสดงการเลือก Access granted to… 

 

5.6.1. วิธีการ Import iCal ผ่านหน้า webmail 

ไปยัง Calendar > เมนู   > Import Calendar Data > Open 

 

รปูที่ 5-6-2 แสดงการ Import iCal 
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5.6.2. วิธีการ Export iCal ผ่านหน้า mail Client 

1. Outlook ให้เปิดปฏิทิน แล้วเลือกปฏิทินที่คุณต้องการส่งออก 

2. Click File > Save Calendar 

 

รปูที่ 5-6-3 แสดงวิธีการ Outlook ให้เปิดปฏิทิน แล้วเลือกปฏิทินที่คุณต้องการส่งออก 

 

 

รปูที่ 5-6-4 แสดงวิธีการ Click File > Save Calendar 
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5.7. การตั้งค่า Chat 
เป็นการตั้งค่า Chats ในระบบ Web Samoware ซึ่งสามารถกําหนดการบันทึกการสนทนา (Auto-save 

Chats) และการกําหนดที่อยู่ของ Chat จากนั้นจึงทําการอัพเดทค่าที่เปลี่ยนแปลง 

 

รูปที่ 5-7 แสดงการตั้งค่า Chat 

 

 

รูปที่ 5-7-1 แสดงการ Auto-save Chats  
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5.8. ระบบงาน (Tasks) 
สามารถทำได้โดยการคลิกไปยัง Tasks และเม่ือคลิกแล้วก็จะเข้าสู่กล่องข้อความระบบงานหลัก 

คลิกท่ีไอคอน + กรอกรายละเอียดของ Tasks งาน 

 

รูปที่ 5-8 แสดงระบบงาน (Tasks) 

 

To ระบุผูร้ับหรือผู้เข้าร่วมในงาน 
Summary หัวเรื่องของงาน 
Attachments ระบุไฟล์แนบท่ีต้องการส่ง 
Starts วันท่ี (เริ่ม) งาน 
Due วันสิ้นสุดงาน 
Private สถานนะความเป็นส่วนตัว 

Percent เปอร์เซ็นต์ของงานท่ีสำเร็จแล้ว 
Message ข้อความส่วนตัว 
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รูปที่ 5-8-1 แสดงระบบงาน (Tasks) 
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บทท่ี 6 

การกำหนดค่า Share Folders ใน Web Samoware 
 

6.1. การกำหนด Share Folders ให้ผู้อื่น 
1. ผู้ใช้งานสามารถกำหนด Share Folder ให้ผู้อื่นได้เลือกโฟลเดอร์ที่ต้องการแชร์ และคลิก “Edit” 

 

รูปที่ 6-1 แสดงการกำหนด Share Folder 

 

กรอกอีเมลแอดเดรสที่ต้องการแชร์ ในช่อง Access Control List โดยสามารถกำหนดสิทธ์ในการเข้าถึง 

เ ช ่ น  Read, Write, Admin หร ื อ  Custom (Lookup, Select, Seen, Flags, Insert, Create, Delete แ ล ะ 

Admin) จากนั้นคลิก “Save”  

 

รูปที่ 6-2 แสดงการเลือกอีเมลแอดเดรสและกำหนดสิทธิ์การเข้าถึง 
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6.2. การรับ Share Folders จากผู้อื่น 
1. หากผู้ใช้งานได้รับสิทธิ์ในการ Share folder จะได้รับจดหมาย Access Control List จากนั้น 

  คลิก “Subscribe”  

 
รูปที่ 6-3 แสดงการได้รับจดหมาย Access Control List จากการ Share folder 

 

2. ระบบจะส่งไปยังหน้าต่าง Folder Subscription จากนั้นคลิก “Save”  

 

รูปที่ 6-4 แสดงการบันทึก Folder Subscription 

 

3. ระบบเมลจะแสดงโฟลเดอร์ที่ได้รับการ Share 

 

รูปที่ 6-5 แสดงโฟลเดอร์ของผู้อื่น 
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6.3. วิธีการ Share Address Books (Contacts) 

ไปยัง Contacts > Address Books > เมนู  > Access Control List > กรอกอีเมลที่ต้องการให้

สิทธิ์ > กำหนดสิทธิ์ > save 

 

รูปที่ 6-6 แสดงการ Share Address Books 

 

 

รูปที่ 6-7 แสดงการ Share Address Books 
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รูปที่ 6-8 แสดงการ Share Address Books 

 

6.4. การใช้งาน Buddies  
รายชื่อ Buddies จะเป็นบัญชีรายชื่อสามารถกำหนดให้กับกลุ่มบัญชีรายชื่อหนึ่งหรือหลายกลุ่ม เมื่อผู้ใช้

บัญชีเพ่ิมบัดดี้ลงในบัญชีรายชื่อ รายชื่อจะถูกส่งไปยังที่อยู่บัดดี้ หากผู้รับยืนยันคำขอนี้ "เป็นเพื่อน" สถานะบัดดี้ใน

ข้อมูลสถานะบัญชีรายชื่อจะกลายเป็น "ยืนยัน" และท้ังสองฝ่ายสามารถเห็นสถานะการแสดงตนของกันและกันได้ 

 

รูปที่ 6-9 แสดงการ การใช้งาน Buddies 

 


